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ABSTRAK 
 

The compounds in Aegle marmelos have an activity as anti inflammation. The objective of this study is 
to evaluate six active compounds in Aegle marmelos Correa, (E,R)- Marmin, skimmianine, (S)-aegeline, 
aurapten, zeorin, and dustanin as anti inflammation to the COX-1 and COX-2 as target receptors. Method: 
Molecular docking was done with PLANTS. Ligand preparation used MarvinSketch, and protein preparation 
was done by using YASARA. The result was marmin, skimmianine, aegeline, aurapten, zeorin, and dustanin 
have interaction with Arg120, tyr 355, and Ile 523 in COX-1 and Ser353, Arg 513, and Ser 530 in COX-2. Based 
on the result of molecular docking, active compounds in Aegle marmelos Correa have potency as anti 
inflammation agent. 
Key word : Marmin, Antiinflamasi, Ligand, COX-1, Docking 
 

ABSTRAK 
 

Senyawa-senyawa yang terdapat dalam Aegle marmelos Correa memiliki aktivitas sebagai 
antiinflamasi. Tujuan penelitian ini adalah untuk mengetahui enam senyawa aktif Aegle Marmelos Correa, 
yaitu (E, R)-Marmin, skimmianine, (S)-aegeline, aurapten, zeorin, dan dustanin sebagai anti inflamasi pada 
target reseptor COX-1 dan COX-2. Metode: Docking molekuler dilakukan dengan PLANTS. Preparasi ligand 
menggunakan MarvinSketch, dengan menggambar senyawa MH2011 kemudian mengoptimasi. Preparasi 
protein dilakukan dengan program YASARA. Preparasi dilakukan dengan menghilangkan protocol docking 
(termasuk air jika esensial) yang tidak diperlukan. Setelah semua preparasi selesai, dilakukan docking 
PLANTS. Penurunan skor menunjukkan kestabilan ikatan dengan protein. Hasil: Marmin, skimmianine, 
aegeline, aurapten, zeorin, and dustanin berpotensial untuk dikembangkan sebagai agen anti inflamasi 
berdasarkan interaksinya dengan residu asam amino Arg120, Tyr 355, dan Ile523 pada COX-1 dan residu 
asam amino Ser353, Arg513, serta Ser530 pada COX-2. Kesimpulan: Berdasarkan hasil docking molecular, 
senyawa aktif Aegle marmelos Correa beraktivitas sebagai antiinflamasi 
Kata Kunci : Marmin, Antiinflamasi, Ligand, COX-1, Docking 
 

PENDAHULUAN 
Indonesia sebagai negara dengan 

biodiversitas nomor dua di dunia memiliki banyak 
potensi untuk mengembangkan pengobatan 
berbahan dasar alam. Berbagai kandungan 
senyawa telah berhasil diisolasi dari tanaman 
untuk dikembangkan dan digunakan sebagai obat 
dalam terapi berbagai penyakit. Saat ini, 
penelusuran senyawa obat baru dari berbagai 
tanaman   terus  dilakukan, beberapa   diantaranya  
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adalah marmin [(7-(6’,7’-dihidroksigeranil-oksi) 
kumarin], skimmianin [4,7,8-(trimetoksifuro         
(2,3-b)quinolin], aegelin [N-[2-hidroksi-2(4-
metoksifenil) etil]-3-fenil-2-propenamid], 
aurapten, zeorin, dan dustanin yang merupakan 
senyawa aktif yang banyak terkandung pada kulit 
batang dan kortek akar Aegle marmelos Correa 
(Nugroho et al., 2010; Nugroho et al., 2011a; 
Nugroho et al., 2011b). Marmin dilaporkan sangat 
poten dalam menghambat pelepasan histamin dari 
kultur sel RBL-2H3 melalui penghambatan Ca2+ 

uptake secara in vitro. Marmin dengan konsentrasi 
100 µM mampu menekan pelepasan histamin 
lebih dari 60% (yang diinduksi dengan DNP24-BSA 
dan thapsigargin) dan lebih dari 50% (yang 
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diinduksi oleh ionomycin) dibandingkan kontrol 
dari kultur sel RBL-2H3 (Nugroho et al., 2011b). 
Marmin juga mampu menghambat influks Ca2+ 

ekstraseluler ke dalam sel RBL-2H3, sehingga 
menghambat pelapasan histamin > 70% 
dibandingkan kontrol (Nugroho et al., 2008). 
Skimmianin dengan konsentrasi 100 µM mampu 
menekan pelepasan histamin hingga 60% (yang 
diinduksi dengan DNP24-BSA dan thapsigargin) 
dan lebih dari 70% (yang diinduksi oleh 
ionomycin) dibandingkan kontrol dari kultur sel 
RBL-2H3 (Nugroho et al., 2010). Aegelin dengan 
konsentrasi 100 µM mampu menekan pelepasan 
histamin hingga 40% (yang diinduksi dengan 
DNP24-BSA) dan lebih dari 50% (yang diinduksi 
oleh thapsigargin dan ionomycin) dibandingkan 
kontrol dari kultur sel RBL-2H3 (Nugroho et al., 
2011a). Selain itu, hasil penelitian Anas (2011).  . 

Selain sebagai antihistamin, terdapat 
beberapa penelitian yang menunjukkan bahwa 
senyawa-senyawa yang terdapat dalam Aegle 
marmelos Correa memiliki aktivitas sebagai 
antiinflamasi. Menurut Dhankhar et al (2011), 
ekstrak organik dari daun Aegle marmelos Correa 
memiliki aktivitas sebagai antiinflamasi akut dan 
sub-akut, analgesik, serta sebagai antipiretik. 
Ekstrak metanolik dan ekstrak air dari biji Aegle 
marmelos Correa juga menunjukkan aktivitas 
antiinflamasi yang cukup baik terhadap inflamasi 
akut dan kronis (Sharma et al., 2011). Ekstrak air 
dari kulit batang akar Aegle marmelos Correa juga 
menunjukkan aktivitas sebagai antiinflamasi 
terhadap inflamasi akut dan kronis yang cukup 
baik (Benni et al., 2011). Obat-obat antiinflamasi 
dibagi menjadi dua golongan utama, yaitu 
golongan kortikosteroid dan non-steroid. Obat 
Anti Inflamasi Non Steroid (OAINS) yang banyak 
beredar di pasaran saat ini bekerja dengan cara 
menghambat sintesis prostaglandin, suatu 
senyawa mediator inflamasi. Prostaglandin 
terbentuk dari asam arakidonat dengan bantuan 
enzim siklooksigenase (COX). Enzim ini memiliki 
dua isoform, yaitu COX-1 dan COX-2. Mekanisme 
senyawa-senyawa dalam Aegle marmelos Correa 
sebagai antiinflamasi diduga berhubungan dengan 
interaksi senyawa tersebut dengan enzim 
siklooksigenase, yaitu sebagai penghambat enzim 
COX-1 maupun COX-2.   

Pada saat ini, pengembangan obat-obatan 
tidak hanya dilakukan secara eksperimental, 
tetapi juga dilakukan secara kimia komputasi. 
Dalam perkembangan obat, cara kimia komputasi 
memiliki beberapa keunggulan, seperti 
mengurangi biaya dan menghemat waktu 
penelitian. Cara kimia komputasi saat ini cukup 
banyak dilakukan dalam penemuan dan 
pengembangan obat untuk memprediksi 
penempatan gugus farmakofor (gugus fungsi        

aktif) suatu molekul secara tiga dimensi (Richon, 
1994). Salah  satu metode  yang  digunakan   untuk 
menganalisis afinitas suatu molekul obat adalah 
docking molekuler.  

Docking molekuler banyak digunakan untuk 
memberikan gambaran tentang interaksi, ikatan, 
maupun afinitas suatu ligan (obat) dengan 
reseptornya, maupun enzim dengan substrat atau 
inhibitornya. Docking juga dapat digunakan untuk 
memprediksi apakah suatu senyawa memiliki 
aktivitas atau tidak, serta dapat berguna dalam 
pengembangan senyawa dengan aktivitas yang 
lebih baik. Pengembangan senyawa aktif dari 
Aegle marmelos Correa sebagai antihistamin 
(antagonis reseptor histamin H1) maupun 
antiinflamasi (inhibitor enzim COX) juga dapat 
dilakukan secara kimia komputasi. Pengembangan 
tersebut di antaranya mencakup desain senyawa 
dan interaksi senyawa tersebut dengan enzim atau 
reseptor. Dalam hal ini, senyawa aktif dari Aegle 
marmelos Correa perlu diuji interaksinya dengan 
reseptor H1 maupun enzim COX-1 dan COX-2 
melalui uji in silico. Apabila hasil uji in silico 
menunjukkan interaksi yang baik antara senyawa 
aktif dari Aegle marmelos Correa dengan reseptor 
H1 maupun enzim COX, maka dapat dilakukan uji 
in vivo lebih lanjut untuk mengetahui tingkat 
keamanannya, sehingga senyawa tersebut dapat 
dikembangkan lebih lanjut sebagai sediaan 
antihistamin maupun antisiklooksigenase 
(antiinflamasi) yang poten. 

 

METODOLOGI 
Bahan dan Alat Penelitian 

Struktur protein-protein sebagai target 
maya, diunduh dari website Protein Data Bank 
(http://www.rcsb.org/pdb). Protein-protein 
tersebut adalah enzim COX-1 dengan kode PDB 
1EQH, 1HT5, dan 1HT8; serta enzim COX-2 dengan 
kode PDB 6COX, 4COX, dan 3PGH. Sebagai ligan uji 
digunakan 6 senyawa aktif dari Aegle marmelos 
Correa, yaitu (E,R)-marmin, skimmianin, (S)-
aegelin, aurapten, zeorin, dan dustanin. Sebagai 
pembanding antihistamin digunakan pembanding 
antiinflamasi digunakan paracetamol, aspirin, 
indometasin, dan celecoxib. 

Alat penelitian yang dibutuhkan yaitu: 
seperangkat komputer (Windows-XP dengan 
prosesor Dual-Core dan RAM 1GB), jaringan 
internet, software PLANTS (http://www.tcd.uni-
konstanz.de/research/plants.php), MarvinSketch 
5.2.5.1 2009 ChemAxon ( http://www.chemaxon. 
com), YASARA 12.2.22 (http://www.yasara.org), 
Visual Molecular Dynamics 1.9.1 Windows ( 
http://www.ks.uiuc.edu/Research/vmd/), 
Pendrivelinux 2009 http://www. pendrivelinux. 
com).  

 

http://www.yasara.org/
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Preparasi ligan  
Senyawa yang digunakan dalam penelitian 

yaitu Aegle marmelos Correa, yaitu (E,R)-marmin, 
skimmianin, (S)-aegelin, aurapten, zeorin, dan 
dustanin. Senyawa ini digambarkan struktur dua 
dimensinya secara manual menggunakan 
MarvinSketch (program ChemAxon 5.2). 
Kemudian struktur yang terbentuk dilakukan 
optimasi protonation dengan metode Major 

Microspecies untuk mendapatkan struktur yang 
disesuaikan dengan PH darah. Optimasi 
berikutnya adalah menentukan konformasi yang 
paling sesuai dan cocok dengan reseptor COX-1 
dan COX-2, penentuan konformasi ini dengan 
menggunakan metode conformers. Terdapat 10 
konformasi yang mewakili semua posisi ligand 
terhadap pocket. Konformasi yang paling sesuai 
dapat diketahui dengan docking PLANT. 

Tabel I. Nilai RMSD hasil validasi 
 

Kode PDB RMSD (Å) 
1EQH 1,7758 
1HT5 2,2311 
1HT8 0,8130 
6COX 1,2183 
4COX 1,2118 
3PGH 0,4394 

 
Tabel II. Skor Docking Ligan dengan enzim COX-1 
 

NO Kode PDB Ligan Skor Docking 
1 1EQH 

RMSD : 1,7758 Å 
Native FLP (konformasi 3) -94,7869 
(E,R)-Marmin (konformasi 5) -88,4930 
Skimmianin (konformasi 2) -69,0035 
(S)-Aegelin (konformasi 4) -87,5282 
Aurapten (konformasi 10) -89,2538 
Zeorin (konformasi 10) -25,7431 
Dustanin (konformasi 10) -16,9143 
Paracetamol (konformasi 6) -65,3364 
Aspirin (konformasi 10) -67,0704 
Indometasin (konformasi 9) -74,5894 
Celecoxib (konformasi 1) -45,6009 

2 1HT5 
RMSD : 2,2311 Å 

Native FL2 (konformasi 3) -90,0368 
(E,R)-Marmin (konformasi 8) -91,5791 
Skimmianin (konformasi 2) -69,3127 
(S)-Aegelin (konformasi 6) -89,0779 
Aurapten (konformasi 6) -95,5941 
Zeorin (konformasi 10) -41,8568 
Dustanin (konformasi 5) -40,7153 
Paracetamol (konformasi 8) -67,6595 
Aspirin (konformasi 8) -70,4562 
Indometasin (konformasi 10) -92,2391 
Celecoxib (konformasi 3) -63,8106 

3 1HT8 
RMSD : 0,8130 Å 

Native 34C (konformasi 1) -84,5337 
(E,R)-Marmin (konformasi 7) -87,7189 
Skimmianin (konformasi 2) -65,1815 
(S)-Aegelin (konformasi 2) -91,4108 
Aurapten (konformasi 4) -94,0435 
Zeorin (konformasi 5) -15,1772 
Dustanin (konformasi 1) -19,0637 
Paracetamol (konformasi 4) -65,4839 
Aspirin (konformasi 7) -70,1549 
Indometasin (konformasi 10) -88,9998 
Celecoxib (konformasi 3) -66,0344 
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Preparasi Protein Enzim 
Homologi modeling dilakukan dengan 

membuka program YASARA. File fasta dari 6COX, 
kemudian load file pdb 6COX ke YASARA. 
Kemudian dihapus bagian dari sistem yang tidak 
diperlukan dalam protocol docking (yang 
dibutuhkan hanya satu protein, termasuk air jika 
esensial, dan satu ligand). Delete chain B (Edit > 
Delete > Molecule); pilih sequence B, Name B, 
Belongs to or has All, dan klik “OK”. Delete 
deterjen (NAG) yang masih ada dalam sistem (Edit 
> Delete > Residu); pilih name NAG, Belongs to or 
has All, dan klik “OK”. Tambahkan hydrogen ke 
dalam system dengan bantuan YASARA, sebab 
resolusi struktur Kristal tidak mampu 
memprediksi keberadaan hydrogen (Edit > Add > 
Hydrogen to: all). Simpan file sebagai YASARA 
Object (File > Save as > YASARA Object), simpan 
sebagai COX-2.yob.  

Delete ligand asli sehingga hanya 
menyisakan protein target saja dengan pocket 
untuk docking (Edit > Delete > Residue); Pilih 
Name S58, Belongs to or has All, klik “OK” ,simpan 
sebagai protein.mol2. Koordinat pocket dapat 
diketahui dengan merujuk pada koordinat ligand 
3D asli. Untuk itu hanya diperlukan file mol2 yang 
hanya berisi ligand asli.  

 
Docking PLANTS 

Buka “console” di Co-Pendrivelinux-KDE, 
kemudian ketik perintah “cp 
/mnt/win/docking_plants/PLANTS PLANTS”. 
Setelah muncul perintah berikutnya ketik “chmod 
u+x PLANTS” lanjutkan dengan “./PLANTS” untuk 
mengaktifkan program PLANTS. Untuk 
memasukkan protocol docking yang diperlukan 
ketik “cp /mnt/win/docking_plants/*.mol2.” 
kemudian aktifkan plantsconfig dalam proses 

Tabel III. Skor Docking Ligan dengan enzim COX-2 
 
NO Kode PDB Ligan Skor Docking 
1 6COX 

RMSD : 1,2183 Å 
Native SC-558 (konformasi 3) -71,5020 
(E,R)-Marmin (konformasi 1) -86,8678 
Skimmianin (konformasi 6) -72,9922 
(S)-Aegelin (konformasi 7) -96,2835 
Aurapten (konformasi 3) -87,3071 
Zeorin (konformasi 3) -39,4475 
Dustanin (konformasi 6) -41,9447 
Paracetamol (konformasi 6) -67,4056 
Aspirin (konformasi 9) -72,1648 
Indometasin (konformasi 6) -101,4380 
Celecoxib (konformasi 5) -85,6108 

2 4COX 
RMSD : 1,2118 Å 

Native IMN (konformasi 10) -87,6053 
(E,R)-Marmin (konformasi 2) -94,9186 
Skimmianin (konformasi 2) -69,8888 
(S)-Aegelin (konformasi 8) -97,5863 
Aurapten (konformasi 10) -94,2375 
Zeorin (konformasi 4) -54,2411 
Dustanin (konformasi 5) -67,6303 
Paracetamol (konformasi 1) -68,7735 
Aspirin (konformasi 10) -74,6695 
Indometasin (konformasi 9) -106,419 
Celecoxib (konformasi 3) -81,4847 

3 3PGH  
RMSD : 0,4394 Å 

Native FLP (konformasi 3) -88,7400 
(E,R)-Marmin (konformasi 5) -96,2381 
Skimmianin (konformasi 1) -72,8249 
(S)-Aegelin (konformasi 1) -97,2794 
Aurapten (konformasi 1) -94,2722 
Zeorin (konformasi 1) -45,6478 
Dustanin (konformasi 7) -55,9832 
Paracetamol (konformasi 6) -70,8967 
Aspirin (konformasi 10) -75,3236 
Indometasin (konformasi 10) -97,7794 
Celecoxib (konformasi 3) -82,0446 
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docking “cp /mnt/win/docking_plants/ plants-
config.” lalu ketik “./PLANTS mode bind 
ref_ligand.mol2 5 protein.mol2” untuk 
memasukkan pocket ke dalam protein yang 
digunakan sebagai tempat berikatannya dengan 
reseptor. apabila terdapat peringatan “PLANTS 
warning” maka dilakukan perbaikan secara 
manual dengan cara mengetik “kwrite 
ref_ligand.mol2” kemudian ganti “S.O2” dengan 
“S.o2”, setelah di save maka perbaikan sudah 
dilakukan.  

Setelah dilakukan perbaikan pada 
ref_ligand maka ketik “grep -Ev “# binding site 
definition” plantsconfig > temp_conf” lanjutkan 
dengan “grep -Ev “bindingsite_” temp_conf > 
temp_conf2”. Untuk mengaktifkan pesan galat 
diatas ketik “cat temp_conf2 bindingsite.def > 
plantsconfig”. Setelah semua preparasi selesai 
maka running docking dilakukan dengan mengetik 
“./PLANTS --mode screen plantsconfig” kemudian 
akan muncul 10 konformasi ligand yang berikatan 
dengan 6COX dan 1HT8 dengan energi yang 
berbeda-beda. Untuk evaluasi dan iterpretasi data 
hasil docking ketik “cd results/” lanjutkan dengan 
“more bestranking.csv”. hasil skor docking akan 
muncul, kemudian dari 10 input konformasi 
dipilih yang memiliki energi paling kecil.  
 

HASIL DAN PEMBAHASAN 
Validasi Metode Docking 

Validasi metode docking pada penelitian ini 
dilakukan dengan me-redocking ligan native pada 
tiap kelompok protein yang diunduh dari situs 
PDB (Protein Data Bank). Untuk evaluasi validasi, 
parameter yang dilihat adalah RMSD (Root Mean 
Square Deviation) dan pose secara visual 
(Moitessier et al., 2008). RMSD merupakan 
pengukuran dua pose dengan membandingkan 
posisi atom antara struktur eksperimental dengan 
struktur yang di-docking-kan atau yang diprediksi 
(Hawkins et al., 2008) . Nilai RMSD < 2,0 Å 
biasanya digunakan sebagai kriteria kesuksesan 
metode docking (Jain and Nicholls, 2008; 
Moitessier et al., 2008) . Semakin kecil nilai RMSD 
menunjukkan bahwa pose ligan yang diprediksi 
semakin baik karena semakin mendekati 
konformasi native. Akan tetapi, sebenarnya belum 
ada standar nilai RMSD yang digunakan sebagai 
parameter kesuksesan metode docking. 

Tahap awal pada proses validasi ini adalah 
pemilihan protein, serta preparasi protein dan 
ligan. Pemilihan protein dari situs PDB didasarkan 
pada protein yang diinginkan untuk diuji. Untuk 
enzim siklooksigenase-1 (COX-1) dipilih protein 
dengan kode PDB 1EQH, 1HT5, dan 1HT8. PDB 
dengan kode 1EQH merupakan kompleks enzim 
COX-1 dengan flurbiprofen, 1HT5 merupakan 
kompleks enzim COX-1 dengan metil ester 

flurbiprofen, sedangkan 1HT8 merupakan 
kompleks enzim COX-1 dengan alclofenac. Untuk 
enzim siklooksigenase-2 (COX-2) dipilih protein 
dengan kode PDB 6COX, 4COX, dan 3PGH. PDB 
dengan kode 6COX merupakan kompleks antara 
enzim COX-2 dengan inhibitor selektif SC-558, 
4COX merupakan kompleks antara enzim COX-2 
dengan inhibitor non-selektif Indometasin, 
sedangkan 3PGH merupakan kompleks antara 
enzim COX-2 dengan inhibitor non-selektif 
Flurbiprofen. 

Dari hasil scoring di atas, telah diketahui 
masing-masing konformasi paling optimal yang 
menghasilkan nilai terendah. Konformasi paling 
optimal tersebut selanjutnya akan digunakan 
dalam analisis RMSD (dibandingkan dengan 
referensinya) untuk mengetahui apakah protokol 
docking yang digunakan memiliki reprodusibilitas 
yang baik atau tidak. Hasil analisis RMSD dapat 
dilihat pada (tabel 1). 

 
Docking Senyawa Uji pada Enzim COX-1 

Dalam uji in silico (docking) senyawa 
marmin, skimmianin, aegelin, aegelin, aurapten, 
zeorin, dan dustanin sebagai inhibitor enzim 
siklooksigenase-1 (COX-1), dipilih 3 protein dari 
situs PDB, yaitu 1EQH, 1HT5, dan 1HT8. PDB 
dengan kode 1EQH  merupakan kompleks enzim 
COX-1 dengan flurbiprofen, 1HT5 merupakan 
kompleks enzim COX-1 dengan metil ester 
flurbiprofen, sedangkan 1HT8 merupakan 
kompleks enzim COX-1 dengan alclofenac. Sebagai 
senyawa pembanding digunakan paracetamol, 
aspirin, indometasin, serta celecoxib. 

Proses docking diawali dengan preparasi 
ligan uji, yaitu marmin  [(7-(6’,7’-
dihidroksigeranil-oksi) kumarin], skimmianin 
[4,7,8-(trimetoksifuro(2,3-b)quinolin], aegelin [N-
[2-hidroksi-2(4-metoksifenil) etil]-3-fenil-2-
propenamid], aurapten, zeorin, dan dustanin, serta 
ligan pembanding, yaitu paracetamol, aspirin, 
indometasin, serta celecoxib dengan piranti lunak 
MarvinSketch version 5.2.5.1 Preparasi dilakukan 
dengan menggambarkan molekul ligan uji dan 
pembanding secara manual pada jendela 
MarvinSketch version 5.2.5.1, seperti yang terlihat 
pada gambar 7 dan 9 dilanjutkan dengan 
protonasi dan pencarian 10 konformasi yang 
optimal. Ligan yang telah dipreparasi kemudian 
di-docking-kan pada protein-protein yang telah 
divalidasi sebelumnya. Skor hasil docking ligan 
native, ligan uji, maupun pembanding dengan 
enzim COX-1 dapat dilihat pada (tabel II). 

Dari hasil docking yang memprediksi 
interaksi senyawa marmin, skimmianin, aegelin, 
aurapten, zeorin, dan dustanin dengan enzim COX-
1 dari protein dengan kode PDB 1EQH (tabel XIII), 
diketahui bahwa nilai skor dari senyawa-senyawa 
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tersebut masih lebih tinggi bila dibandingkan 
dengan ligan native-nya, yaitu flurbiprofen. Hal ini 
dapat menunjukkan bahwa kompleks ikatan 
protein dengan ligan native masih lebih stabil 
(kuat) dibandingkan dengan kompleks antara 
protein dengan senyawa aktif dari Aegle marmelos 
Correa. Sedangkan apabila dibandingkan dengan 
senyawa pembandingnya (paracetamol, aspirin, 
indometasin, dan celecoxib), nilai skor marmin, 
aegelin, dan aurapten ternyata lebih rendah, yang 
dapat mengindikasikan bahwa kompleks antara 
protein dengan marmin, aegelin, atau aurapten 
lebih stabil (kuat) dibandingkan dengan kompleks 
protein dengan senyawa pembanding. Hal ini 
menunjukkan bahwa marmin, aegelin, dan 
aurapten memiliki potensi untuk dikembangkan 
sebagai agen antiinflamasi yang cukup poten. 
Sedangkan skor skimmianin, masih lebih tinggi 
bila dibandingkan dengan indometasin, tetapi 
lebih rendah daripada skor paracetamol, aspirin, 
serta celecoxib, yang dapat berarti bahwa 
skimmianin juga berpotensi untuk dikembangkan 
sebagai antiinflamasi. Apabila skor senyawa-
senyawa aktif Aegle marmelos Correa 
dibandingkan, terlihat bahwa zeorin dan dustanin 
menunjukkan skor yang jauh lebih tinggi, yang 
dapat mengindikasikan afinitas kedua senyawa 
tersebut pada enzim COX-1 tidak baik, serta dapat 
dikatakan bahwa kedua senyawa tersebut tidak 
memiliki aktivitas sebagai inhibitor enzim COX-1.  

Dari hasil visualisasi terlihat bahwa 
senyawa uji (marmin, skimmianin,  aegelin, 
aurapten, zeorin, dan dustanin) dapat berinteraksi 
dengan residu asam amino Arg120, Tyr 355, serta 
Ile523 dari enzim COX-1 dengan jarak ikatan yang 
berbeda-beda. Apabila dilihat dari jarak ikatannya, 
interaksi-interaksi tersebut dapat diduga berupa 
ikatan hidrogen, maupun gaya van der Waals. Dari 
hasil visualisasi juga terlihat bahwa senyawa-
senyawa pembanding (paracetamol, aspirin, 
indometasin, dan celecoxib) dapat berinteraksi 
dengan Arg120, Tyr 355, serta Ile523 dari enzim 
COX-1 dengan jarak ikatan yang bervariasi. 
Apabila dilihat dari jarak ikatannya, jarak ikatan 
antara residu-residu asam amino tersebut dengan 
ligan native dan indometasin (pembanding) lebih 
dekat bila dibandingkan dengan jarak ligan-ligan 
uji, sedangkan jarak senyawa pembanding lain 
(paracetamol, aspirin, dan celecoxib) lebih jauh. 
Hal tersebut menunjukkan bahwa kekuatan ikatan 
antara kompleks protein dengan ligan native 
maupun indometasin lebih kuat dan stabil 
dibandingkan dengan kompleks protein dan ligan-
ligan uji, dan kompleks protein-ligan uji masih 
lebih kuat dan stabil daripada kompleks protein 
dengan paracetamol, aspirin, maupun celecoxib. 
Kekuatan ikatan ini juga terbukti dari skor ligan 
native dan indometasin yang memang relatif lebih 

baik bila dibandingkan dengan skor ligan uji. 
Dengan melihat hasil scoring dan interaksi secara 
visual, marmin, aegelin, dan aurapten memiliki 
potensi untuk dikembangkan lebih lanjut sebagai 
agen antiinflamasi (COX inhibitor). 

 
Docking Senyawa Uji pada Enzim COX-2 

Dalam uji in silico (docking) senyawa 
marmin, skimmianin, aegelin, aurapten, zeorin, 
dan dustanin sebagai inhibitor enzim 
siklooksigenase-2 (COX-2), dipilih 3 protein dari 
situs PDB, yaitu 6COX, 4COX, dan 3PGH. PDB 
dengan kode 6COX merupakan kompleks antara 
enzim COX-2 dengan inhibitor selektif SC-558, 
4COX merupakan kompleks antara enzim COX-2 
dengan inhibitor non-selektif Indometasin, 
sedangkan 3PGH merupakan kompleks antara 
enzim COX-2 dengan inhibitor non-selektif 
Flurbiprofen. 

Proses docking diawali dengan preparasi 
ligan uji, yaitu marmin  [(7-(6’,7’-
dihidroksigeranil-oksi) kumarin], skimmianin 
[4,7,8-(trimetoksifuro(2,3-b)quinolin], aegelin [N-
[2-hidroksi-2(4-metoksifenil) etil]-3-fenil-2-
propenamid], aurapten, zeorin, dan dustanin, serta 
ligan pembanding, yaitu paracetamol, aspirin, 
indometasin, serta celecoxib dengan MarvinSketch 
version 5.2.5.1 Preparasi dilakukan dengan 
menggambarkan molekul ligan uji dan 
pembanding secara manual pada jendela 
MarvinSketch version 5.2.5.1, seperti yang terlihat 
pada gambar 7 dan 9 dilanjutkan dengan 
protonasi dan pencarian 10 konformasi yang 
optimal dan di-docking-kan dengan software 
PLANTS. Skor hasil docking ligan native, ligan uji, 
maupun pembanding pada enzim COX-2 dapat 
dilihat pada (tabel III) 

Dari hasil docking yang memprediksi 
interaksi senyawa marmin, skimmianin, dan 
aegelin dengan enzim COX-2 dari protein dengan 
kode PDB 6COX (tabel XV), terlihat bahwa 
marmin, skimmianin, aegelin, dan aurapten 
memiliki skor yang lebih rendah dibandingkan 
dengan ligan native (SC-558). Hal ini menunjukkan 
bahwa kompleks antara protein dengan ligan uji 
tersebut lebih stabil dibandingkan dengan 
kompleks protein-ligan native. Apabila 
dibandingkan dengan ligan pembandingnya, skor 
marmin, skimmianin, aegelin, dan aurapten masih 
lebih tinggi daripada indometasin, tetapi lebih 
rendah bila dibandingkan dengan pembanding 
yang lain. Hasil tersebut menunjukkan bahwa 
kompleks antara protein dengan indometasin 
menjadi kompleks yang paling stabil bila 
dibadingkan dengan kompleks protein-ligan uji, 
dan kompleks protein-ligan uji masih lebih stabil 
bila dibandingkan dengan kompleks protein-ligan 
pembanding lainnya (paracetamol, aspirin, dan 
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celecoxib). Dari keenam senyawa aktif Aegle 
marmelos Correa yang diuji, zeorin dan dustanin 
memiliki skor yang relatif tinggi bila dibandingkan 
dengan senyawa uji lain, ligan native, maupun 
pembanding yang digunakan. Hal tersebut 
menunjukkan bahwa afinitas zeorin dan dustanin 
terhadap enzim COX-2 kurang baik, dan dapat 
dikatakan bahwa kedua senyawa tersebut tidak 
memiliki aktivitas sebagai inhibitor enzim COX-2. 
Hasil scoring tersebut dapat digunakan sebagai 
salah satu dasar pengembangan marmin, 
skimmianin, aegelin, serta aurapten sebagai agen 
antiinflamasi yang cukup poten.  

Dari hasil visualisasi terlihat bahwa 
senyawa uji (marmin, skimmianin, aegelin, 
aurapten, zeorin, dan dustanin) dapat berinteraksi 
dengan residu asam amino Ser353, Arg513, serta 
Ser530 dari enzim COX-2 dengan jarak ikatan yang 
bervariasi. Apabila dilihat dari jarak ikatan ligan 
dengan residu asam amino, interaksi-interaksi 
tersebut dapat diduga berupa ikatan hidrogen, 
maupun gaya van der Waals. Apabila dilihat dari 
jarak ikatannya, jarak ikatan antara residu-residu 
asam amino Ser353, Arg513, serta Ser530 dengan 
ligan uji marmin, aegelin, dan aurapten lebih dekat 
bila dibandingkan dengan jarak residu-residu 
asam amino dengan ligan native dan pembanding 
(paracetamol, aspirin, dan celecoxib), tetapi masih 
lebih jauh daripada jarak residu asam amino 
dengan pembanding indometasin. Sedangkan 
jarak ikatan antara residu asam amino dengan 
ligan uji lain masih lebih jauh bila dibandingkan 
dengan ligan native maupun pembandingnya. Hal 
ini menunjukkan bahwa kekuatan ikatan antara 
protein dengan marmin, aegelin, maupun 
aurapten lebih kuat dan stabil bila dibandingkan 
dengan kekuatan ikatan protein dengan ligan 
native, paracetamol, aspirin, dan celecoxib, tetapi 
lebih lemah bila dibandingkan dengan kekuatan 
ikatan protein dengan indometasin. Di antara 
senyawa-senyawa aktif dari Aegle marmelos 
Correa yang diuji, zeorin dan dustanin memiliki 
kekuatan ikatan yang relatif lemah bila 
dibandingkan dengan kekuatan ikatan antara 
protein dengan ligan native maupun senyawa 
pembanding yang digunakan. Kekuatan ikatan ini 
juga terbukti dari hasil scoring yang menunjukkan 
bahwa indometasin memiliki skor terendah, 
zeorin dan dustanin memiliki skor yang relatif 
lebih tinggi. Dengan melihat hasil scoring dan 
interaksi secara visual, marmin, aegelin, dan 
aurapten memiliki potensi untuk dikembangkan 
lebih lanjut sebagai agen antiinflamasi (COX 
inhibitor).  

 

KESIMPULAN 
Urutan senyawa dengan skor terbaik pada 

uji anti COX-1 adalah sebagai berikut : ligan natve 

FLP > aurapten > (E,R)-marmin > (S)-aegelin >  
indometasin > skimmianin > aspirin > 
paracetamol > celecoxib > zeorin > dustanin (kode 
PDB 1EQH). Aurapten > indometasin > (E,R)-
marmin > ligan native FL2 > (S)-aegelin > aspirin > 
skimmianin > paracetamol > celecoxib > zeorin > 
dustanin (kode PDB 1HT5). Aurapten > (S)-aegelin 
> indometasin > (E,R)-marmin > ligan native 34C > 
aspirin > celecoxib > paracetamol > skimmianin > 
dustanin > zeorin (kode PDB 1HT8). Residu-residu 
asam amino yang diduga terlibat dalam interaksi 
protein-ligan antara lain adalah Arg120, Tyr 355, 
dan Ile523. 

Urutan senyawa dengan skor terbaik pada 
uji anti COX-2 adalah sebagai berikut : 
indometasin > (S)-aegelin > aurapten > (E,R)-
marmin > celecoxib > skimmianin > aspirin > ligan 
native SC-558 > paracetamol > dustanin > zeorin 
(kode PDB 6COX). Indometasin > (S)-aegelin > 
(E,R)-marmin > aurapten > ligan native IMN > 
celecoxib > aspirin > skimmianin > paracetamol > 
dustanin > zeorin (kode PDB 4COX). Indometasin 
> (S)-aegelin > (E,R)-marmin > aurapten > ligan 
native FLP > celecoxib > aspirin > skimmianin > 
paracetamol > dustanin > zeorin (kode PDB 
3PGH). Residu-residu asam amino yang diduga 
terlibat dalam interaksi protein-ligan antara lain 
adalah Ser353, Arg513, serta Ser530. 
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